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COURSE OBJECTIVES 

By the end of this course you will be able to: 

 Correctly create a new specified project, without reference to notes. 

 Correctly define a project dates, referring to notes if necessary. 

 Correctly change a calendar working times, referring to notes if necessary.  

 Correctly close a project and save changes, without reference to notes. 

 Correctly create, edit and re-order specified tasks, without reference to notes. 

 Correctly organise tasks into phases, referring to notes if necessary. 

 Accurately create recurring tasks, without reference to notes. 

 Correctly add notes to tasks, without reference to notes. 

 Accurately set milestones in a project, referring to notes if necessary.  

 Correctly set dependencies between tasks, referring to notes if necessary. 

 Correctly change the completed status of a task, referring to notes if necessary.  

 Correctly create specified work and material resources, without reference to notes. 

 Correctly assign resources to tasks, referring to notes if necessary. 

 Briefly describe how to change views. 

 Briefly describe what a resource pool is. 

 Correctly create specified headers and footers, referring to notes if necessary. 

 Correctly change the page setup, referring to notes if necessary. 

 Briefly describe how to print the built-in reports.  
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MODULE 1 – INTRODUCTION 

OBJECTIVES 

At the end of this section you will be able to: 

 Correctly create a new specified project, without reference to notes. 

 Correctly define a project dates, referring to notes if necessary. 

 Correctly change a calendar working times, referring to notes if necessary.  

 Correctly close a project and save changes, without reference to notes. 

WHAT IS PROJECT MANAGEMENT? 

Project Planning consists of Planning, Organising and Managing the Activities and Means which lead to 

the achievement of a Defined Objective within a fixed period of time. 

There is no single correct way to manage a project; however there are 4 clearly defined steps to 

managing a project. 

1. Project Definition 

The first stage is used to define  

 What goals to accomplish, which major tasks (and how many) are needed to achieve these goals. 

 What resources, i.e. people and equipment, are available to accomplish the goals? 

 How much time is available to complete the project?  What are the milestones & deadlines? 

2. Project Plan 

This is the heart of project management.  It defines the scope, resources and schedule in one place thus 

enabling you to keep these factors in balance throughout the project.  For an effective project plan: 

 Identify all project tasks and who or what will do them. 

 Get work and time estimates for tasks, preferably from the people responsible for those tasks. 

 Determine task dependencies, e.g. find out if one task must be completed before the next can be 

started, or if several tasks must start at the same time etc. 

 Establish task and project constrains, e.g. if a task must be started on a certain date. 

3. Tracking the Project 

When the project begins the Plan helps you to direct and fine-tune the project: 

 Track project progress, comparing actual data to original estimates. 

 Review resource, scope and schedule factors to balance priorities. 

 Identify problems that could know the project off schedule. 

 Analyze resource requirements throughout the project. 

 Make midstream changes that will help you reach the project goal sooner. 
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4. Closing the Project 

Once all the project goals have been achieved and all criteria met, that signals the project's end, it’s time 

to close the project.  This now enables you to: 

 Compare the original plan to the actual course of project event. 

 Analyse problems and identify areas for future improvement. 

 Archive the project file. 

DEVELOPING YOUR PLAN 

Once you have defined your project objectives, the next step is to plan how you will achieve them.  

There are four key things we need to consider when setting up the Project Plan.  The way to define and 

achieve your goals is to build a list of Tasks.  The logical grouping of these tasks which completes a 

major step is known as a Milestone. 

Key Points 

1. List Tasks/Activities & Milestones. 

2. Determine the relationship between tasks. 

3. Estimate the duration of each task. 

4. Construct the network. 

5. Optimise the network. 

Tasks 

Tasks (or activities) are the basic building blocks of the project.  In order to carry out a project you need 

to carry out a sequence of tasks.  To manage the project effectively you need to define your tasks so that 

they are the right size to be effectively managed and completed 

Deliverables 

Sometimes referred to as Products and are the things that the project will produce along the way.  

Typically reports, requirements documents, and acceptance certificates. 

Milestones 

A milestone represents an event or condition that marks the completion of a group of related tasks or a 

phase of the project.  Milestones are intermediate objectives which indicate the state of progress of the 

project.  A project should have a milestone at the start date and another to mark the completion date.  In 

Project 2016, milestones usually have a duration value of zero because it marks a specific point in the 

schedule when a phase of the project is completed. 

Resources 

To accomplish a task you need resources.  Resources can include people, equipment or special facilities 

necessary to perform the task.  The number of resources you use affects both the duration and the cost 

of your project. 

WHAT IS PROJECT 2016? 

Microsoft Project 2016 provides all the tools you need for effective planning, tracking, problem solving, 

sharing, and completing a project in keeping with conventional management principles and practices. 
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Office Project Standard 2016 is designed for managers who do not need to collaborate with others to 

build their projects or select resources. Office Project Professional 2016 is designed for project and 

resource managers who work with others across an enterprise to share schedules and resources by 

connecting to Office Project Server 2016 or SharePoint Foundation 2016.  This course does not cover 

Office Project Server 2016 or SharePoint Foundation 2016 features.  

THE PROJECT ENVIRONMENT 

Using the Ribbon 

The Ribbon is designed to help you quickly find the commands that you need to complete a task. 

Commands are organized in logical groups, which are collected together under tabs. Each tab relates to 

a type of activity, such as working with tasks or resources. To reduce clutter, some tabs are shown only 

when needed. 

There is no way to delete or replace the Ribbon with the toolbars and menus from the earlier versions of 

Microsoft Office. However, you can customise the Ribbon and also minimize it to make more space 

available on your screen. 

To minimize the Ribbon  

1. Right-click anywhere on the Ribbon and select Collapse the Ribbon or alternatively, 

double-click the name of any tab 

2. To use the Ribbon while it is minimized, click on the tab you want to use, and then click 

the option or command you want to use. 

To restore the Ribbon 

1. Right-click anywhere on the Ribbon and click on Collapse the Ribbon (This will clear 

the tick next to this option) or alternatively, double-click any tab again to restore the 

Ribbon. 

Customising the Quick Access Toolbar 

The Quick Access Toolbar is a customizable toolbar that contains a set of commands that are 

independent of the tab that is currently displayed. You can move the Quick Access Toolbar from one of 

the two possible locations, and you can add buttons that represent commands to the Quick Access 

Toolbar. 

The Quick Access Toolbar can be located in one of two places - either in the upper-left corner next to 

the File tab, or below the Ribbon. 

 

 

To move the Quick Access Toolbar 

1. Click on the Customize Quick Access Toolbar button. 

2. In the list, click on Show Below the Ribbon or Show 

Above the Ribbon as required. 

You can add a command to the Quick Access Toolbar directly from 

commands that are displayed on the Ribbon. 
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To quickly add a command to the Quick Access Toolbar 

1. On the Ribbon, click on the appropriate tab or group to display the command that you 

want to add to the Quick Access Toolbar.  

2. Right-click on the required command, and select Add to Quick Access Toolbar on the 

shortcut menu.  

Notes: 

You cannot increase the size of the buttons. The only way to increase the size of the buttons is to 

lower the screen resolution you use.  

You cannot display the Quick Access Toolbar on multiple lines.  

Customising the Ribbon 

The Ribbon is customizable also. You can create new tabs and also new groups both on the new tabs 

and in existing tabs. You can also add new buttons to new groups. You cannot delete any of the built-in 

tabs, groups or buttons. Buttons can only be added to custom groups, not to existing built-in groups. 

To add a new tab or new group to the Ribbon 

1. Right-click anywhere on the Ribbon 

2. Click on the Customize the Ribbon… option. The Customize Ribbon dialog is 

displayed.  

3. The right-hand pane initially shows 

the Main tabs and the currently 

selected Ribbon tab will be 

expanded in the pane to show the 

various groups. Click on any of the + 

signs to expand the display and give 

more detail. To view the other 

available tabs that can be customised 

click on the drop-down selector 

above the right-hand pane and 

choose All Tabs or Tool Tabs as 

required. 

4. Do one or more of the following: 

 To create a new tab, click on the 

New Tab button below the right-

hand pane. The new tab will be inserted below the currently selected tab, together with a 

default empty new group. 

 To create a new group, click on the New Group button below the right-hand pane. The 

new group will inserted at the end of the existing groups in the currently selected tab. 

Note: To reposition the tab/group click on the tab/group then use the up and down arrows to 

the right of the right-hand pane to reposition, while the tab/group name is selected. 

To rename a new tab or group 

1. Right-click anywhere on the Ribbon 
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2. Click on the Customize the Ribbon… option. The 

Customize Ribbon dialog is displayed. 

3. Select the tab or group entry in the right-hand pane. 

4. The Rename dialog is displayed as shown here. Type a 

new name in the Display name box at the bottom. 

5. If you want the button to have an associated icon, 

choose one by clicking on one from the displayed 

Symbol collection. 

6. Finally, click on OK. 

To add a new button to a group 

1. Right-click anywhere on the Ribbon 

2. Click on the Customize the Ribbon… option. The Customize Ribbon dialog is 

displayed. 

3. In the right-hand pane, right-click on the tab and group that will hold the button. 

4. In the left-hand pane select the button that you wish to add. 

5. Click on the Add>> button. 

Note: To reposition the button use the up and down arrows at the side of the right-hand pane 

while the added button is selected in the right-hand pane. 

To delete a previously created tab, group or button. 

1. Right-click anywhere on the Ribbon 

2. Click on the Customize the Ribbon… option. The Customize Ribbon dialog is 

displayed. 

3. In the right-hand pane, click on the tab, group or button to delete. 

4. Click on the <<Remove button. 

To reset ribbon customisations 

1. Right-click anywhere on the Ribbon 

2. Click on the Customize the Ribbon… option. The Customize Ribbon dialog is 

displayed. 

3. Click on the rest button below the right-hand pane, and choose Reset All 

Customisations or Reset Only Selected Ribbon Tab as required. Note: Reset Only 

Selected Ribbon Tab is only available when you are looking at a built-in tab that has 

been customised by having new buttons or groups inserted. 
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EXERCISE 1  

1. Create a new Blank Project. 

2. Click on the File tab, and look at the project’s information. Use Advanced Properties to set 

the title of New Product Brochure and your name as the Author. Close the Advanced 

properties down when the changes have been made and return to viewing the Project tab of 

the Ribbon. 

3. Set the project Start date to next Monday. 

4. You are now going to create a new Project Calendar for use in the project. Using the 

Change Working Time dialog, create a new calendar (a new base calendar) and name the 

new Calendar Working Week. It should have the following attributes. 

a. For Monday through to Thursday the working day should start at 08:30 until 12:30 then 

13:00 until 17:00. 

b. For Friday the working day should start at 08:30 until 12:30 then 13:00 until 16:00. 

c. Mark the 25th of December, as a recurring public holiday (non-working time) for 10 

recurrences. 

d. Select the Options button and ensure the Default Start Time is set to 08:30. 

5. Now view the Project Information dialog.  Change the calendar for the project to the 

Working Week calendar. 

6. Now close this project and save it as New Product Brochure. 
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EXERCISE 2  

1. Open the New Product Brochure file. 

2. Create a new summary task and rename it as Write Brochure. Leave the Duration, Start and 

Finish dates as they are. 

3. In the second row of the Gantt table underneath Write Brochure, rename the New Task as 

Research new product 

4. Create the following new tasks each on separate rows: 

Create an outline 

Write a rough draft 

Final Draft Approved  

Create mailing list 

5. Create a summary task above row 1 named Marketing New Product. Leave the Duration, 

Start and Finish dates as they are. 

6. Add another task at the bottom with the name Build list. 

7. Indent Build list so it becomes a sub-task of Create mailing list 

8. Set the duration of Build list to 4 days. 

9. Move the Create mailing list task (including sub-task) so it is positioned above Write 

brochure. 

10. Set the duration of the Research New Product task to 2 days. Because you manually changed 

the duration of the task, the question mark which indicated an estimated duration 

disappeared. Change the duration back to an estimated 2 days.  

11. Creating some new tasks starting in row 9. Use the following: 

Get quotes from printers 

Prepare through desktop publishing 

Get printed 

12. Set the duration of Get quotes from printers to 2 days. 

13. Insert a summary task above row 9. Give it the name of Print Brochure 

14. Using the Outdent button once, make the Print Brochure summary task the same level as 

Write brochure. Notice when Print Brochure becomes a summary task the three tasks below 

it become its subtasks.  

15. We will now enter the remaining tasks in our project from row 13 down. They are: 

Distribute Brochure 

Do mass mail out 

16. Using the Outdent button once, make row 13 a Summary Task (i.e. out-dented once at the 

same level as the summaries above it). 

17. Now save the changes to the file and close it down but keep project running. 
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